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BEA WebLogic Integration
Release Notes

BEA WebLogic Integration Release 2.1 Service Pack 2
Date: July 2002

Revised: September 2003

Change History

The following table lists the changes included in BEA WebLogic Integration 2.1 
Service Pack 2 since the initial release.

Release Note Topics

This document includes the following topics:

About This Release of BEA WebLogic Integration

Date Summary of Changes

November 21, 2002 Added certification information for SuSE Linux. For more information, see “Platform 
Support and System Requirements” on page 5.

September 23, 2003 Added support information. For more information, see “Platform Support and System 
Requirements” on page 5.
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What Is New and Improved in This Release

Platform Support and System Requirements

Best Practices

Problems Fixed in This Release

Known Limitations

Installation and Migration

BEA dev2dev Online

Contacting BEA Customer Support

For this release, only the Release Notes have been revised. Please use the information 
in these Release Notes in conjunction with the WebLogic Integration 2.1 SP1 
documentation set located on the BEA documentation Web site at the following URL:

http://edocs.bea.com

About This Release of 
BEA WebLogic Integration

BEA WebLogic Integration 2.1 Service Pack 2 (SP2) is a single, unified platform that 
provides the functionality needed to integrate business systems within an enterprise, 
and to link those systems in a collaborative arrangement with an organization’s trading 
partners.

Underlying this functionality is the industry-leading J2EE application server, BEA 
WebLogic Server, which provides the critical infrastructure needed to develop 
integrated solutions that support transaction management, security, fault tolerance, 
persistence, and clustering.

WebLogic Integration 2.1 SP2 supports end-to-end business integration by providing 
functionality in the following areas:
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What Is New and Improved in This Release
Business process management makes possible the development of complex 
e-business processes that integrate existing enterprise systems, cross-enterprise 
applications, and human decision makers.

Application integration makes it possible to integrate existing enterprise 
applications with each other, and with new e-business applications. 

B2B integration makes possible the connection of trading partners over the 
Internet, and the integration of EDI environments with WebLogic Integration.

Data integration supports the seamless exchange of various data formats 
between applications and between trading partners over the Internet.

What Is New and Improved in This Release

BEA WebLogic Integration 2.1 Service Pack 2 (SP2) delivers the following new 
functionality and enhancements:

Support for BEA WebLogic Server 6.1 SP3

WebLogic Integration 2.1 SP2 now supports WebLogic Server 6.1 SP3 in 
addition to WebLogic Server 6.1 SP2.

Full installer and service pack upgrade installer

A full WebLogic Integration 2.1 SP2 installer is available. Use the full 
installation if you have never installed WebLogic Integration or if you have 
WebLogic Integration 2.0 or earlier installed.

If you already have WebLogic Integration 2.1 or WebLogic Integration 2.1 SP1 
installed, and you have a BEA WebSUPPORT account, you can use the service 
pack upgrade installer. Information about downloading these installers is 
provided in Installing BEA WebLogic Integration at the following URL:
http://edocs.bea.com/wlintegration/v2_1sp/install/index.htm

The BPM Timer Services have been changed to allow multiple workflow 
instances to be processed simultaneously. For more information, see “Time 
Services Changes in BPM” on page 62.

The Data Integration functionality now provides an enhanced version of 
Message Format Language, MFL Version 2.02, including three new features. For 
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information on these features, see “Data Integration Padding and Truncation 
Features” on page 65. 

Support for WebLogic Integration - Business Connect 7.0

WebLogic Integration - Business Connect enables you to securely exchange 
large volumes of documents with your trading partners. WebLogic Integration - 
Business Connect packages documents in secure envelopes that are transmitted 
among trading partners according to schedules.

Detailed information about this component of WebLogic Integration is available 
at the following URL:
http://e-docs.bea.com/wlibc/docs70/index.html

Support for Contivo Analyst 3.5

WebLogic Integration 2.1 SP2 supports Contivo Analyst 3.5. This software 
extends the data transformation capabilities of your data integration 
environment. Refer to the documentation packaged with the Contivo Analyst 
software. Contivo Analyst software can be downloaded from the BEA Download 
Center at the following URL:
http://commerce.bea.com/downloads/weblogic_integration.jsp

Version information logged at startup

Version information is now written to the server log at startup. This enhancement 
was added in response to CR081976. The following sample shows a portion of 
the output to the server log:

####<Jul 4, 2002 3:57:48 PM EDT> <Info> <WLI> <mysystem> <myserver>
<main> <system> <> <000000> 
<Weblogic Integration version: 
Weblogic Integration BPM MDB Generator 2.1 SP2 07/04/2002 15:35:43 EDT #21159
Weblogic Integration Studio 2.1 SP2 07/04/2002 15:35:43 EDT #21159 
Weblogic Integration Worklist 2.1 SP2 07/04/2002 15:35:43 EDT #21159 
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Platform Support and System Requirements
Platform Support and System Requirements

The following sections contain the platforms supported for WebLogic Integration 2.1 
SP2, including the hardware and software requirements:

BEA WebLogic Integration Release 2.1 Service Pack 2 as of July 2002

BEA WebLogic Integration Release 2.1 Service Pack 2 as of November 2002

BEA WebLogic Integration Release 2.1 Service Pack 2 as 
of July 2002

The following table provides a list of the platforms supported for WebLogic 
Integration 2.1 SP2 as of July 2002.
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Table 1.  Platform Support for WebLogic Integration 2.1 SP2

Operating System 
and version

WebLogic 
Integration 
Version

Required 
WebLogic 
Server 
Version

Required 
JDK 
(included 
with WLS 
installation

Hardware 
Requirements

DBMS Supported1

Microsoft Windows 
NT 4.0 (SP6 or 
higher)
Microsoft Windows 
2000 Professional
Microsoft Windows 
2000 Advanced 
Server

2.1 SP2 6.1 SP4
6.1 SP3
6.1 SP2

1.3.1 Intel Pentium II 
or higher at 400 
MHz (or higher) 
256 MB RAM 
minimum (512 
MB RAM 
recommended)

100 MB free disk 
space for 
program software

TCP/IP network 
interface

Persistent 
Internet 
Connection

Cloudscape 3.5.1
Oracle 8.1.7, 9i
Microsoft SQL 
Server 7 (SP3 or 
higher), 20002

Sybase System 11.9.2

2.1 SP1 6.1 SP2
6.1 SP3 (AI 
requires a 
patch)

Cloudscape 3.5.1
Oracle 8.1.6, 8.1.7
Microsoft SQL 
Server 7 (SP3 or 
higher), 2000
Sybase System 11.9.2

Sun Solaris 2.6

Sun Solaris 7

Sun Solaris 83

2.1 SP2 6.1 SP4

6.1 SP3

6.1 SP2 

1.3.1 UltraSparc 5 or 
higher

Sparc 168 MHz 
or higher

256 MB RAM 
minimum (512 
MB RAM 
recommended)

100 MB free disk 
space for 
program software

TCP/IP network 
interface

Persistent 
Internet 
Connection

Oracle 8.1.7, 9i
Microsoft SQL 
Server 7 (SP3 or 
higher), 2000
Sybase System 11.9.2

2.1 SP1 6.1 SP2

6.1 SP3 (AI 
requires a 
patch)

Oracle 8.1.6, 8.1.7

Microsoft SQL 
Server 7 (SP3 or 
higher), 20002

Sybase System 11.9.2
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Platform Support and System Requirements
Hewlett-Packard 
HP-UX 11.0, 
HP-UDX 11i4

2.1 SP2 6.1 SP4

6.1 SP3

6.1 SP2

1.3.1 HP 9000 PA 
RISC at 100 MHz 
or higher

256 MB RAM 
minimum (512 
MB RAM 
recommended)

100 MB free disk 
space for 
program software

TCP/IP network 
interface

Persistent 
Internet 
Connection

Oracle 8.1.7, 9i

Microsoft SQL 
Server 7 (SP3 or 
higher), 20002

Sybase System 11.9.2

2.1 SP1 6.1 SP2

6.1 SP3 (AI 
requires a 
patch)

Oracle 8.1.6, 8.1.7

Microsoft SQL 
Server 7 (SP3 or 
higher), 2000

Sybase System 11.9.2

IBM AIX 5.1 2.1 SP2 6.1 SP3

6.1 SP2

RS/6000 
PowerPC or 
higher at 200 
MHz or faster

256 MB RAM 
minimum (512 
MB RAM 
recommended)

280 MB free disk 
space for 
program software

TCP/IP network 
interface

Persistent 
Internet 
Connection

Oracle 9i R2

2.1 SP1 6.1 SP2

6.1 SP3 (AI 
requires a 
patch

Oracle 8.1.7

IBM DB2 7.2

Table 1.  Platform Support for WebLogic Integration 2.1 SP2

Operating System 
and version

WebLogic 
Integration 
Version

Required 
WebLogic 
Server 
Version

Required 
JDK 
(included 
with WLS 
installation

Hardware 
Requirements

DBMS Supported1
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IBM AIX 4.3.3 with 
Performance Pack

2.1 SP2 6.1 SP4

6.1 SP3

6.1 SP2

1.30 (Classic 
VM with JIT 
enabled)

RS/6000 
PowerPC or 
higher at 200 
MHz or faster

256 MB RAM 
minimum (512 
MB RAM 
recommended)

280 MB free disk 
space for 
program software

TCP/IP network 
interface

Persistent 
Internet 
Connection

Oracle 8.1.7

IBM DB2 7.2

2.1 SP1 6.1 SP2

6.1 SP3 (AI 
requires a 
patch)

2.1 6.1 SP1

Table 1.  Platform Support for WebLogic Integration 2.1 SP2

Operating System 
and version

WebLogic 
Integration 
Version

Required 
WebLogic 
Server 
Version

Required 
JDK 
(included 
with WLS 
installation

Hardware 
Requirements

DBMS Supported1
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Platform Support and System Requirements
Red Hat Linux 7.2 
(on IA)

2.1 SP2 6.1 SP4

6.1 SP3

6.1 SP2

Sun JDK 
1.3.1_03 
(downloade
d and 
installed 
separately)

Intel Pentium II 
or higher at 400 
MHz (or higher)

256 MB RAM 
minimum (512 
MB RAM 
recommended)

100 MB free disk 
space for 
program software

TCP/IP network 
interface

Persistent 
Internet 
Connection

Sybase 11.9.2 via 
Sybase jConnect

2.1 SP1 6.1 SP2 Sun JDK 
1.3.1_01 
(downloade
d and 
installed 
separately)

Oracle 8.1.7

SuSE Linux 
Enterprise Server 7.0 
for S/390 and zSeries

2.1 SP2 6.1 SP3 JDK - IBM 
1.3.1 JVM 
Service 
Refresh 2 
Special 
Build 
(APAR 
PQ63617)

S/390 or zSeries 
architecture

1 GB RAM

280 MB free disk 
space for 
program software

TCP/IP network 
interface

Persistent 
Internet 
Connection

IBM DB2 7.2

Oracle 9i/9.2

Table 1.  Platform Support for WebLogic Integration 2.1 SP2

Operating System 
and version

WebLogic 
Integration 
Version

Required 
WebLogic 
Server 
Version

Required 
JDK 
(included 
with WLS 
installation

Hardware 
Requirements

DBMS Supported1
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BEA WebLogic Integration Release 2.1 Service Pack 2 as 
of November 2002

As of November 2002, WebLogic Integration 2.1 SP2 has been certified on the 
following platform:

Operating System: SuSE Linux Enterprise Server 7 for S/390 kernel version 
2.4.7 (May 2002)

Required JDK: IBM 1.3.1 JVM Service Refresh 2 Special Build (APAR 
PQ63617). For information on downloading this JVM build, see:
http://e-docs.bea.com/wls/certifications/certifications/
suse_linux_s390.html#41429

WebLogic Server Version: 6.1 SP3 

1. Cloudscape is a pure-Java relational database management system that BEA includes with WebLogic
Server to allow you to run code samples. It is supported on Windows platforms for development use only;
it is not when used in a production environment. Cloudscape is not supported on UNIX platforms.

Oracle connectivity is supported with the Oracle thin driver. 

For Microsoft SQL Server, Oracle, Sybase, or DB2, WebLogic Integration must have network access to
the database server. You must also have a database server account with sufficient privileges to create a
database with tables. 

The JDBC2 driver for Sybase is not bundled with WebLogic Server. You can download it directly from
the Sybase Web site. For download instructions, see the BEA WebLogic Server 6.1 Installation Guide,
available at the following URL: http://edocs.bea.com.

2. The Solaris operating system patches for Java 2 JDK, including the Solaris OpenWindows Motif
patches, are required if you install the software using the GUI installation procedure. The patches are
available at the following URL: http://java.sun.com/j2se/1.3/install-solaris-patches.html.

3. HP-UX 11i (aka HP-UX 11.11) is a supported environment as per Hewlett Packard's statement of binary
compatibility between HP-UX 11.0 and HP-UX 11i.

4. SQL Server 2000 is supported with WebLogic Integration 2.1 Service Pack 2 (running on WebLogic
Server 6.1 Service Pack 4), but requires that the patch for CR083328 be applied. This patch can be obtained
from BEA Customer Support.
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Best Practices
Supported DBMS: DB2 7.2 and Oracle 9i/9.2

Best Practices

This section contains the following usage information about WebLogic Integration 
components and functions:

Specifying JAVA_HOME for Red Hat Linux

Settings Required for Running WebLogic Integration on HP-UX 11.0

Oracle 9i Driver Setup for RosettaNet 2 Security Sample

Using the Proper JDK

Support for Null Variables

Design-Time Web Application JSP Delivery Change

Sample Email Adapter Deprecated

Addressed Messaging

Nested Workflows

Calling Programs Using SendXMLToClient

BPM Plug-Ins in a UNIX Environment

Deploying B2B on a Managed Server

Improving XSLT Performance

Specifying JAVA_HOME for Red Hat Linux

The JDK required for use with Red Hat Linux is not provided with WebLogic Server. 
Download and install Sun JDK 1.3.1_01 separately before installing WebLogic 
Server.
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WebLogic Integration looks for the JDK in BEA_HOME. Because the JDK is installed 
separately, choose one of the following methods to point to the correct JAVA_HOME. In 
both methods, JAVA_HOME is the directory in which you installed JDK 1.3.1_01.

Use the following commands to point to the proper JAVA_HOME before setting 
your environment. 

cd  $BEA_HOME
ln  -s  $JAVA_HOME JAVA_HOME

Use the following commands to change the definition of JAVA_HOME in 
$WLI_HOME/setenv.sh to point to the directory in which you installed JDK 
1.3.1_01.

cd $WLI_HOME
JAVA_HOME=JAVA_HOME

Settings Required for Running WebLogic Integration on 
HP-UX 11.0

Changes to default configuration settings and parameters are required to run 
WebLogic Integration on an HP-UX 11.0 system.

In WLI_HOME/setenv.sh, locate the following lines:

HP-UX) 
JAVA=$JAVA_BIN/java 
JAVAC=$JAVA_BIN/javac 
JAVA_OPTIONS="-Djava.compiler=NONE -Xms128m -Xmx512m" 
export JAVA JAVA_OPTIONS JAVAC 

Change:

JAVA_OPTIONS="-Djava.compiler=NONE -Xms128m -Xmx512m" 

to:

JAVA_OPTIONS="-hotspot -Xms256m -Xmx256m"

Also, set the max_thread_proc to 512 and max_users to 128. You must have root 
access to make this change.
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Best Practices
Oracle 9i Driver Setup for RosettaNet 2 Security Sample

If you experience failures when running the RosettaNet 2 Security sample on Solaris 
systems using the Oracle 9i thin driver, ensure that the driver has been properly set up. 
Unlike the other samples which use the WLICP and WLISERVERCP values specified in 
the setenv script, the RosettaNet 2 Security sample refers to its own setup. Add the 
Oracle 9i thin driver to START_WL_CLASSPATH in the startWeblogic script for both 
the peer1 and peer2 domains. This issue was originally reported as CR081061.

Using the Proper JDK

Ensure that you are using JDK version 1.3.1. On a Windows NT or Windows 2000 
machine, WebLogic Integration installation fails at the Choose Install Set window if 
you are using a version of the JDK that is earlier than 1.3.x.

Note: JDK 1.3.1 is shipped with WebLogic Server 6.1, so it should already be 
installed on your system.

If you have not installed the JDK on a new Windows NT or Windows 2000 system, 
then the installer fails when the Choose Install Set window is displayed, instead of 
giving you the option of selecting or creating a BEA_HOME directory.

Add BEA_HOME\jdk131\bin to the Windows PATH environment variable. Install JDK 
1.3.1 on the target machine and start the installation again.

This issue was originally reported as CR065631.

Support for Null Variables

WebLogic Integration 2.1 SP2 supports null values in variables through the 
wli.bpm.server.evaluator.supportsNull option in the startWebLogic script. 
When this option is set to true, all variables are initialized to a null value. When this 
option is set to false, all variables are initialized to their default values. The default 
setting for this option is false.

For details about this option, see Starting, Stopping, and Customizing BEA WebLogic 
Integration.
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Design-Time Web Application JSP Delivery Change

The following information will be added to “Migrating Adapters to WebLogic 
Integration 2.1” in Developing Adapters in a future release.

As of WebLogic Integration 2.1 Service Pack 1, sample adapters (eMail, DBMS, and 
sample) no longer distribute the JSP pages in a Web application archive (WAR). 
Rather, the JSP pages are precompiled into Java Servlet classes. This approach 
eliminates the need to precompile JSP pages when WebLogic Server starts. The Java 
Servlet classes are delivered in the WEB-INF\classes\jsp_servlet directory in a 
WAR file. Since the JSP pages are not bundled into the WAR file, the adapter 
developer needs to establish the mapping between a URL pattern and a specific Java 
Servlet class in the Web application descriptor WEB-INF/web.xml.

For each JSP page for your adapter, provide a Servlet declaration. For example,

<servlet>
<servlet-name>confconn</servlet-name>
<servlet-class>jsp_servlet.__confconn</servlet-class>

</servlet>

This declares a Servlet named confconn and associates it with a Java Servlet class 
jsp_servlet.__confconn. The Web application container looks for this class in the 
WEB-INF/classes directory in the WAR file. After declaring all Servlet classes, 
associate each Servlet with a URL pattern via a servlet-mapping.

<servlet-mapping>
<servlet-name>confconn</servlet-name>
<url-pattern>confconn.jsp</url-pattern>

</servlet-mapping>

This servlet-mapping associates all HTTP requests for confconn.jsp to the 
confconn Servlet in your Web application. The adapter developer must have a 
servlet-mapping for all Servlets in the Web application. See the sample adapter’s 
web.xml file for an example of all Servlet declarations and mappings needed for an 
adapter.

Sample Email Adapter Deprecated

The sample Email adapter is deprecated in this release of WebLogic Integration. The 
Email adapter will be removed from the product in a future release.
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Best Practices
Addressed Messaging

Use addressed messaging whenever you want guaranteed message delivery.

Nested Workflows 

Nested workflows must be analyzed for scalability because they can lead to transaction 
timeouts. The parent of a transaction timeout envelops all children.

Calling Programs Using SendXMLToClient

Be careful about enabling access to a shell program, such as cmd.exe, because doing 
so effectively defeats the SecurityManager, making it possible for a malicious 
workflow to launch anything on the client computer. For better security, list only those 
programs needed to execute the workflow.

WLPISec.properties contains a list (one item per line) of unqualified executable 
files, such as the following:

cmd.exe

winword.exe

mm.exe

BPM Plug-Ins in a UNIX Environment

The plug-in architecture uses the Image object from the AWT library. As a result, the 
server needs to have the DISPLAY environment variable set in order to create this 
object. The plug-in simply sends the image file across the wire and allows the client to 
create the Image object.

When a UNIX system is used, an issue arises. Because the plug-ins make a connection 
to the Xwindow server, logging off can bring WebLogic Server down, as well, even if 
you start it with NOHUP and run it in background mode. For this reason plug-ins should 
never instantiate any class that needs the Xwindow server.
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Deploying B2B on a Managed Server

To run WebLogic Integration B2B functionality on a managed server, add the 
following system property to the Weblogic startup script:

-Dwli.b2b.server.managedserver.deployed=true

This system property was added in response to CR070619. 

If you are not using a managed server configuration, ensure that this system property 
is not present in the startup script. Also, when running WebLogic Integration on a 
managed server, do not deploy any application integration components since they 
cannot currently be deployed in Managed Server mode. 

Improving XSLT Performance

If you frequently use XSLT, take the following actions to help improve XSLT 
performance:

increase the heap size to at least 512m

add the following JVM option to the java command in your startWeblogic 
script or to $JAVA_OPTIONS in your setenv script
-XX:NewSize=128m -XX:MaxNewSize=128m

These steps are recommended for all users with enough memory to do so, but they 
become even more important when using XSLT because of its high short-term 
memory usage. See Tuning Performance in Deploying BEA WebLogic Integration 
Solutions for further information about JVM options. 
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Problems Fixed in This Release
Problems Fixed in This Release

The following table lists selected problems fixed in BEA WebLogic Integration 2.1 
SP2, including a CR (Change Request) number for each problem. Most of these 
problems were originally documented in the Release Notes for BEA WebLogic 
Integration Release 2.1 or BEA WebLogic Integration Release 2.1 SP1. For a complete 
list of problems fixed in BEA WebLogic Integration 2.1 SP2, contact BEA Customer 
Support.

Table 2.  Problems Fixed in BEA WebLogic Integration 2.1 SP2

Change Request 
Number

Description

CR058127 Japanese characters not displayed correctly in RosettaNet 2.0 system test. 

CR058732 Could not send RosettaNet 2.0 message when Trading Partner name was configured as 
Chinese string. 

CR059845 When using the XML Instance Editor, pressing Tab/Shift+Tab should toggle between 
column 1 and column 2.

CR061483 Logging on to the Studio does not reenable the View, Configuration, Tools, and Window 
menus.

CR061745 New user created in Studio does not have any rights assigned.

CR063419 Format Builder truncation enhancement request.

CR063421 Format Builder padding enhancement request. 

CR063934 Multibyte character support problem in Format Builder. 

CR063947 Exception occurred when an event invokes an application integration service which uses 
specific Japanese characters in the service name.

CR064036 TemplateDefinitionProperties dialog responds differently to inputs by mouse and by 
keyboard. 

CR064272 Cannot log on to application integration console when using Japanese characters for the 
user name. 

CR064545 Studio context menus not accessible. 
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CR064686 Calendar feature does not work correctly.
The software now checks that timed starts are within valid calendar periods.

CR064767 XML editor cannot handle repeated structures in XML schemas when minOccurs=0.

CR064792 Cannot update a remote trading partner's certificate from the B2B Console.

CR065049 Japanese characters not displayed correctly in B2B Console. 

CR065153 Unable to use XA driver for wliPool.

CR065390 wlc.log rotation does not work.

CR065575 NullPointerException during XML transformation.

CR066056 Passivation exception thrown when RepositoryResolver is used.

CR066057 Addressed message failed to complete in test case.

CR066062 Problems occur when using Format Builder palette. 

CR066093 WebMethods interoperability problem with MIME header parsing.

CR066216 Workflow label not updated when workflow completes.

CR066249 javax.naming.NameNotFoundException encountered in BPM.

CR066399 Unable to view the Workload Report for a role. 

CR066574 XML date element not validated with xsd:date with com.bea.schema.

CR066711 Calender problems observed on double-byte Windows 2000 platform.

CR066713 A memory leak occurred.

CR066760 NoSuchElementException thrown when XML is added to repository.

CR066810 Format Builder not padding required spaces in COBOL Copybook file.

CR066831 Server crash with internal persistence error occurs after transaction timeout.

Table 2.  Problems Fixed in BEA WebLogic Integration 2.1 SP2 (Continued)

Change Request 
Number

Description
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Problems Fixed in This Release
CR067130 Set Task Due Date unreliable under load.

CR067534 Locks are not released after business message is sent.

CR067836 WebLogic Integration 2.1 SP1 does not work with WebLogic Server 6.1 SP1.

CR068192 ebXML plug-in code is not thread safe.

CR068291 Start public workflow actions are not executed when public workflow ends.

CR068326 Workflow cannot be modified because it is suspended.

CR068465 Server crashes after sending repeated messages of 5MB in size.

CR068632 BPM process does not recognize the user-defined exception handler.

CR068879 Parent workflow not resuming execution after subworkflows complete.

CR069009 NullPointerException in 
com.bea.wlpi.server.workflow.variable.TypedVariable.setValue.

CR069196 Internationalization changes to data integration required to handle escape sequences 
correctly.

CR069270 No means of tracking message status at the sender side when ebXML is used.
The ability to track ebXML message status at the sender side has been added as an option, 
as described in the following steps:
1. Define an envelope variable when sending an ebXML message. 
2. You can retrieve the messageId of the message from the envelope variable after the 

message is sent. For example, given the envelope variable OurEnv, the messageId can 
be retrieved and assigned to a string variable using the following:

ToString(XPath("//Envelope/Header/MessageHeader/
MessageData/MessageId/text()", $OutEnv))

3. You can use the messageId to lookup the Message_History table in the database to find 
the status. For example:

Select status from Message_History where 
messageId='...' and direction='1' 

CR069324 An interoperability error occurs when using WebLogic Integration and Vitria over ebXML.

Table 2.  Problems Fixed in BEA WebLogic Integration 2.1 SP2 (Continued)

Change Request 
Number

Description
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CR069378 Message Store not found if workflow is rolled back.

CR069442 Multipart input stream does not contain boundary with RosettaNet 1.1

CR069519 Need to be able to export and import WebLogic Integration users and roles.
A command line utility is now available to export and import the following security/user 
information: users, roles, organizations, business calendars, and permissions.

CR069633 Optional repeating group is not treated correctly in Format Builder.

CR069883 A SOMSchema validation error occurred.

CR069937 Provide a mechanism for recovery of messages using large message support.
To enable the new large message recovery feature, specify the following option in the 
startWeblogic script:
-Dbea.lmsgrecovery=1

CR070036 Rollback path no longer getting invoked.
Workflow exception handling for transactions has been changed for this release. In prior 
releases of Weblogic Integration, it was possible for an application exception to cause the 
exception handler to execute the rollback actions, even if the transaction was not marked 
for rollback only. This would occur if the commit actions included Exit exception 
handler and rollback. This behavior has been corrected in this release.
Now, rollback actions are executed if and only if, when the workflow processor catches a 
first-chance exception, the user transaction is found to have been marked for rollback only. 
(A first-chance exception is one thrown during normal workflow processing; for example, 
from user code or from an EJB. A second-chance exception is one thrown during exception 
handler processing.)

CR070231 A conversation named 3A2:1.3 already exists.
To support multiple business protocols (RosettaNet-1.1 and RosettaNet-2.0) for the same 
PIP name (e.g., 3A2) and PIP version (for example, 1.3), create separate conversation 
definitions with conversation name using PIP name as prefix (for example, 3A2-RN11 and 
3A2-RN20) for each business protocol.

CR070251 An interoperability error occurs when using WebLogic Integration and Vitria over 
RosettaNet 2.0.

Table 2.  Problems Fixed in BEA WebLogic Integration 2.1 SP2 (Continued)

Change Request 
Number

Description
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Problems Fixed in This Release
CR070352 Escape characters in send XML to client task property do not work.
For more information on handling escape characters, see “Composing XML from 
Sub-Documents” on page 53.

CR070355 XMLTime-to-live parameter does not accept expressions.

CR070361 Format Builder not padding required fields.
For information on Format Builder padding features, see “Data Integration Padding and 
Truncation Features” on page 65.

CR070495 Conversation version format V2.00 is not allowed.

CR070619 B2B console cannot be targeted to a managed server. 

CR071078 No message is logged when invalid security access occurs on host.

CR071209 Escape characters (', " , > ) do not need to be escaped in the Send XML to client action.
Changed com.bea.wlpi.server.common.XMLWriterUtilities to check a flag, 
wli.bpm.server.xml.preserveChars. If true, it will not escape the 3 characters 
listed above. 

CR071452 Server-side authentication support required.
To enable mutual- or server-side authentication per Trading Partner, set the Weblogic 
Server SSL parameter ClientCertificateEnforced to false, set the Weblogic 
Server SSL parameter TwoWaySSLEnabled to true. To be able to use this feature, install 
Weblogic Server patch 73059_61sp2.jar on WebLogic Server 6.1 SP2, or run 
WebLogic Server 6.1 SP3 or later. 
To enable mutual authentication of a Trading Partner, ensure that there is a client certificate 
defined in that remote Trading Partner definition. If this certificate exists, then the remote 
partner must also provide their client certificate. 
To enable server-side authentication of a Trading Partner, remove the client certificate 
from the remote Trading Partner definition. This can be done using the B2B Console or by 
modifying the initial bulk load data file and removing the client certificate. If no certificate 
is defined for the remote Trading Partner, then WebLogic Integration allows a conversation 
with the partner even if no client certificate has been provided. 

CR071583 Tasks are not started after due date or overdue actions. 
Time processing has been fixed to ensure that tasks start as expected after due date or 
overdue actions.

Table 2.  Problems Fixed in BEA WebLogic Integration 2.1 SP2 (Continued)

Change Request 
Number

Description
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CR071815 Message Store not found if workflow rolls back when using RosettaNet protocol.

CR072004 PIP retry results in exception regarding fromId not being set 

CR072097 Initial field focus on Studio and Worklist logon dialog box should be on password field

CR072408 And joins cannot be fired in a loop.

CR072662 Make Studio tool bar buttons sticky.
Double click the toolbar button to lock down the selected tool until another tool is selected 
or you press the escape (ESC) key. You can also hold down the Shift key when drawing 
the current node or line to lock down the current tool. 

CR073009 MIME header of decrypted message content is incorrect 

CR073068 When using WebLogic Integration 2.1 SP1 with WebLogic Integration - Business 
Connect, an ebXML Double Encoding problem occurred when translating text to XML

CR073094 A SAX parser exception is thrown if the attachment content id is <...>.

CR073304 WebLogic Integration - Business Connect cannot recognize MIME content type 
application/binary from WebLogic Integration.

CR073306 WebLogic Integration - Business Connect cannot recognize MIME content type 
application/binary from WebLogic Integration.

CR073348 A memory leak occurred.

CR073480 Unable to assign a cXML Business Protocol Definition to the Doc Exchange using the B2B 
Console.

CR074522 Unable to add an entry to the certificate authority directory.

CR074751 The wliconfig tool changes all connection pools.

CR075020 BPM validating queues are not performing validation.

Table 2.  Problems Fixed in BEA WebLogic Integration 2.1 SP2 (Continued)

Change Request 
Number

Description
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Problems Fixed in This Release
CR075098 Memory leak occurs when a transaction is rolled back when using the ebXML protocol.
An ErrorQListenerBean message-driven bean (MDB) was added that deletes the message 
store when retries on the eventQueue fail.
If you are using ebXML and you make the MDB transactional so that dequeuing from 
eventQueue happens in the same transaction as the rest of the BPM processing, you must 
perform certain tasks to ensure that memory cleanup is performed. To perform the cleanup, 
an MDB with destination-jndi-name, com.bea.b2b.ErrorQueue has been 
added to ebxml-bpm-plugin.jar. This bean cleans the internal memory structures and 
discards the message that was not processed successfully. Edit config.xml as follows to use 
this MDB:
1. Specify an error queue with the correct JNDI name, for example:

<JMSQueue JNDIName="com.bea.b2b.ErrorQueue"
Name="B2bErrorQueue"/>

2. Specify the new error queue as the error destination for eventQueue, for example:

<JMSQueue ErrorDestination="B2bErrorQueue"
JNDIName="com.bea.wlpi.EventQueue" Name="eventQueue"
RedeliveryDelayOverride="10000" RedeliveryLimit="2"/> 

Specify appropriate values for RedeliveryDelayOverride and 
RedeliveryLimit 

CR075425 Missing API for full export of WLI.

CR075427 Problem with XML Schema.

CR075432 Test framework Helper.waitForCompletedInstance() is broken. A memory leak 
occurs.

CR075797 A memory leak occurs when using ebXML.

CR076261 Delayed reply message causes new workflow to start.

CR076401 Carriage return character is stripped out from response.

CR076512 SQL exceptions with Sybase database.

CR076554 RosettaNet test failed because templates were not marked active.

Table 2.  Problems Fixed in BEA WebLogic Integration 2.1 SP2 (Continued)

Change Request 
Number

Description
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CR076649 Need ability to send user-defined fields as part of ebXML message from WebLogic 
Integration - Business Connect to WebLogic Integration B2Bi.

CR076684 Messages are being stuck in the queue.

CR076870 Values cannot be removed from the Proxy tab next to the Security tab in the B2B Console.

CR077009 Long steady state runs result in a slow memory leak.

CR077459 When using the View XML button to display an XML variable in the Studio, spaces in the 
element values from the XML document are not displayed.

CR077547 The server crashes when a CA and Conversation Definition are deleted.

CR077600 Application view does not return correct record factory in Record Translator.
The logic for loading the record translator has been moved into the 
ServiceDeploymentInfo class. 

CR077736 A RosettaNet null pointer exception occurs when fromDUNS is set to a value not declared 
as a business ID in the repository.
The trading partner details are validated prior to use. If the fromDUNS value is null, an 
appropriate message is displayed. 

CR077839 Oracle 9i needs to be supported

CR077879 Workflow cannot be modified because it is suspended

CR077908 SOMValidationException while minOccurs=0 setting is used.

CR078068 Application view does not return correct record factory in Record Translator.

CR078308 Missing dollar sign ($) in setdbdata script.

CR078314 Remote methods are not discovered by a business operation; the inherited methods are 
displayed. 

CR078366 Resizing a print image breaks the number of pages to be printed.
This problem occurred during an attempt to print an image at a zoom value of over 100%. 
The print zoom range has been limited to 0-100%.

Table 2.  Problems Fixed in BEA WebLogic Integration 2.1 SP2 (Continued)

Change Request 
Number

Description
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Problems Fixed in This Release
CR078380 Entity bean collection access problem in Studio.
Removed a restriction on displaying entity EJB home finder methods that return multiple 
objects. All entity EJB home methods are now exposed. 

CR078389 Studio does not allow deletes of large numbers of instances.
The following message and workaround are now displayed when this condition occurs:
A transaction timeout has occurred. This may occur when attempting to delete a large 
number of instances from the database and time for the EJB transaction expires before the 
deletion is complete. 
Suggestion: Use the InstanceDeleter utility provided with WebLogic Integration. For 
details, see the Javadoc page for com.bea.wlpi.util.InstanceDeleter. 

CR078444 Repository conflicts between Studio and application integration.
Folders added to the application integration repository are now displayed correctly.

CR078445 New attribute value not saved in Studio.
A new attribute value is now automatically saved when the dialog box is closed.

CR078447 Start Workflow dialog box shows the same workflow name multiple times with different 
effective dates. Specific workflows cannot be differentiated.

CR078449 Format Builder hangs when saving a format.

CR078507 Problems performing B2B bulk loading when XA driver is used.

CR079118 Server side authentication support required for ebXML.

CR079483 SAX parser exception occurs with custom action plug-in. For fix information, see 
CR079586.

CR079586 Need a public API to list all the tasks in a template definition for use in custom action 
plug-in.
To obtain the getTaskList public API, contact BEA Customer Support for the 
following patch and associated documentation: CR079586_21SP1.zip. This patch also 
contains the fix for CR079483.

CR079697 NullPointerException when an application integration service is tested.

Table 2.  Problems Fixed in BEA WebLogic Integration 2.1 SP2 (Continued)

Change Request 
Number

Description
BEA WebLogic Integration Release Notes 25



CR079698 XML-to- Binary and XML-to-XML transforms fail when the encoding is SJIS, Shift-JIS 
or MS Kanji.

CR079700 Translate XML to Binary failed when encoding of XML file is EUC-JP or UTF-8. 

CR079701 SAXException thrown after Compose Business Message and Extract Business Message 
are processed.

CR079794 XT hangs while attempting to save an mfl document with the IBM 037 encoding type.

CR079883 Application view object mixes up different adapters.
Fixed a problem with the deployment information member variable.

CR080126 A SAX parser exception occurs when importing sample_plug_in.jar workflow 
templates.

CR080182 The Workflow Status window has no column headings.

CR080549 Japanese characters are note displayed correctly or a SAXException occurs when 
Japanese data is used in the ebXML sample.

CR080566 When performing an XSL transform, allow a blank input document and default to the 
following: <_a_/>.

CR080819 The deployment descriptor for wlpi-mdb-ejb.jar is missing entries.
All transaction attributes and method permissions are now explicitly defined.

CR080834 The following exception occurs during an XSL transform: 
java.io.NotSerializableException:
com.bea.wlpi.server.workflow.action.
ActionXSLTransform$XSLParameter

CR080854 The wliconfig script should look for BEA_HOME value in places other than 
c:\beahomelist.

CR081048 The TPName field in the Start Public Workflow action does not allow an expression 
(variable). 

CR081976 Versioning information for WebLogic Integration components.
For sample output, see “What Is New and Improved in This Release” on page 3.

Table 2.  Problems Fixed in BEA WebLogic Integration 2.1 SP2 (Continued)

Change Request 
Number

Description
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Known Limitations
Known Limitations

This section describes known limitations in the BEA WebLogic Integration software.

Change Requests

The following table describes limitations that are documented in formal change 
requests (CRs). Whenever available, a recommended workaround is provided.

1 CR048110

Problem When a data integration user tries to enter values on a tab in a binary window, the text 
being typed is not inserted at the location indicated by the cursor.

Platforms Windows NT and 2000

Workaround Enter your text changes in the text portion of the hex tab of Format Tester.

2 CR050074

Problem If your application startup class is called before the B2B engine startup, the application 
startup tries to access a noninitialized instance of the B2B engine, causing an error such 
as the following: 
ERROR: Collaboration Agreement
CXMLsupplierConversation|1.1|cxml|ACSNHub|AN01000033621-T
is not yet registered in runtime. This error occurs if the
Server is not initialized properly or the
Collaboration Agreement is not registered in runtime by the
WebLogic Integration B2B Console.

Platforms All

Workaround If your application uses a startup class, you must deploy that class before deploying the 
B2B integration startup class.
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3 CR050226

Problem Under the following conditions, WebLogic Integration can start the wrong workflow on 
receipt of a business message:
The same endpoint URI is assigned for different business protocols or different versions 
of the same business protocol.
The repository contains two collaboration agreements between the same trading 
partners.
Those collaboration agreements define the same roles and parties, but are associated with 
different business protocols (or different versions of the same business protocol).

Platforms All

Workaround Assign different endpoint URIs for each business protocol (or for each version of a 
business protocol). 
For example, if one collaboration agreement references RosettaNet 1.1 and the other 
references RosettaNet 2.0 (through the trading partner delivery channels), you must 
assign one endpoint URI for RosettaNet 1.1 and another for RosettaNet 2.0.

4 CR050432

Problem In the Studio, run-time exceptions occur when variable names begin with numeric 
characters.

Platforms All

Workaround Begin variable names with alphabetic characters.

5 CR051059

Problem You cannot update the data for parties in a collaboration agreement in the WebLogic 
Integration B2B Console.

Platforms All

Workaround If you create a party for a collaboration agreement, and subsequently want to modify any 
of the attributes associated with it (such as trading partner name, party identifier, role 
name, or delivery channel), you must delete the party, and then create a new one with the 
desired attributes.
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Known Limitations
6 CR051469

Problem When you use a proxy server and do not set your system to bypass local addresses, you 
get the following error when running the Hello Partner sample:
ERROR> The requested URL could not be retrieved 

Platforms All

Workaround To bypass local addresses, change your Web browser configurations as follows:
Internet Explorer:

Choose Tools→Internet Options →Connections →LAN Settings→ Bypass proxy 
server for local addresses.
Netscape:

Choose Edit→Preferences→Advanced→Proxies→View.
Add your localhost to Exceptions.

7 CR052680  

Problem Apache’s ant command is not internationalized. The ant command is used to build 
application integration adapters. When an error occurs during the build process, the error 
text may not be displayed properly in Windows environments in which the natural 
language used in not English. For example, in a Japanese Windows environment you 
might see the following:
[java] ...\jsp_servlet\_addevent.java:20: ’class’ ??????
’interface’ ?????????????B

Platforms All

Workaround None

8 CR052994

Problem The WebLogic Integration software does not currently provide methods or properties for 
specifying use of the Japanese character set for sending messages and for the 
contentType of the mail header (for example, Content-Type: text/plain; 
charset="ISO-2022-JP"). 

Platforms All

Workaround Email adapter code is provided with WebLogic Integration. Japanese users are free to 
alter this code to allow for the specification of character sets. Keep in mind, however, 
that the sample email adapter does not support multibyte characters.
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9 CR053242 

Problem The WebLogic Integration Studio does not handle time zones correctly. For example, the 
client may send a local date/time string to the server, which then parses the string in its 
own time zone. This procedure creates ambiguities when the server and client are in 
different time zones.
The following areas are affected:
Any entity associated with a date value expressed as a string in which the time zone is 
implicit (for example, workload and statistics queries, and the effective and expiration 
dates for a template definition). 
Any date/time value that the client rounds up or down (for example, task reroutes and the 
effective and expiration dates for a template definition).

Platforms All

Workaround Use GMT for all time values when clients and server span multiple time zones.

10 CR055652 

Problem The Application View connection values for initial and maximum cannot be the same 
number due to a limitation in WebLogic JCA.

Platforms All

Workaround None

11 CR055967 

Problem If you log off from one server and log on to another, the following JMSException is 
thrown. The topic session for the notifier is not released during logoff.
The server was unable to complete your request.
JMSException: Connection not found
Start server side stack trace: 
weblogic.jms.common.JMSException: Connection not found 

Platforms All

Workaround None
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Known Limitations
12 CR057163

Problem Attempt to connect fails because of a license-related exception resulting from the 
absence, from the classpath, of the license.bea file. The pathname may be too long 
for the system to read it. (It is possible that after repeated executions of the setenv 
program, BEA_HOME (D:\bea\), the directory in which the license.bea file 
resides, is no longer included in the classpath.)

Platforms Windows (on Intel)

Workaround Open a new DOS prompt window and try again.

13 CR057562

Problem The names of the roles used in the PIP3A2 template have been changed from Buyer and 
Seller to Customer and Product Supplier.

Platforms All

Workaround If you have private workflows that call the 3A2 private workflows (in a pre-SP1 release 
of WebLogic Integration), you must update the roles in your private workflows.

14 CR058307

Problem The shutdown of a spoke which might have initiated conversations blocks if WebLogic 
Server is shutting down at the same time.

Platforms All

Workaround Always explicitly shut down the B2B engine independently of WebLogic Server using 
the WebLogic Integration B2B Console. If business process management functions are 
running, shut down the process engine first using WebLogic Integration Studio. Next 
shut down the B2B engine, using the WebLogic Integration B2B Console. If shutdown 
of the B2B engine is invoked with the TERMINATE mode, an underlying WebLogic 
Server, listening for incoming requests, is required.

15 CR058949

Problem The Format Builder is unable to open palettes other than the default palette.mfl file.

Platforms All

Workaround Close the Format Builder and rename the file required to be displayed in the palette to 
palette.mfl, then restart the Format Builder.
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16 CR059332
CR058852

Problem Problems have occurred when running WebLogic Integration samples on Windows 2000 
Advanced Server systems over an MSSQL 2000 database.

Platforms Windows 2000 Advanced Server / MSSQL 2000

Workaround The row-locking mechanism has changed between the Microsoft SQL 7.0 and 2000 
databases. A solution is in progress and will be available in a future release.

17 CR059475 

Problem Application integration plug-ins do not detect the status of a wlai-ejb-server when 
the server is down at design time. A message similar to the following is displayed:
The server was unable to complete your request. Unknown error:
NameNotFoundException:
Unable to resolve com.bea.wlpi.Admin. 
Resolved: 'com.bea.wlpi' Unresolved:'Admin' 

Platforms All

Workaround None

18 CR059746, 
CR062984

Problem The introduction of milliseconds as a unit of time broke backward compatibility for 
timed-triggered workflows and for TimedEvent Actions. 

Platforms All

Workaround If you have created workflows with an earlier release of WebLogic Integration (or any 
release of BEA WebLogic Process Integrator), then you must manually reset the correct 
time units in the Start nodes (for timed-triggered workflows) and in all TimedEvent 
Actions.
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Known Limitations
19 CR060313

Problem You cannot uninstall Power.Enterprise! Server or Client software if you try to do so from 
the Windows NT (or Windows 2000) Add/Remove Programs dialog box. The uninstall 
program looks for the jre in the directory from which the Power.Enterprise! software 
was initially installed. 

Platforms Windows

Workaround Select the Uninstall item from the PowerIt program group on the Start menu. At the end 
of the uninstall procedure, you may need to remove the installation directory manually.

20 CR060335

Problem WebLogic Integration fails to create an extended property for a trading partner on UNIX 
systems. An exception similar to the following is displayed:
<Oct 16, 2001 7:11:50 PM GMT-08:00> <Error> <B2B>
<<Repository> ERROR: In SQLExecutor.doUpdate, 
a SQL Exception was caught while executing a SQL 
Statement: java.sql.SQLException: ORA-01400: 
cannot insert NULL into ("BOB"."XML_NODE"."NAME")

Platforms UNIX

Workaround Manually edit the exported XML file to add the extended property. For example, to add 
an extended property for the trading partner named TPSpoke:

From the WebLogic Integration B2B Console, choose B2B→Config→Export.
Select trading partner TPSpoke for export without exporting all referenced entities.
Edit the exported XML file to add the extended property.
Shut down the B2B engine from the WebLogic Integration B2B Console.
Import the modified XML file.
Restart the B2B engine.

21 CR062634

Problem The SendXMLToClient dialog box returns text that does not match the text you 
selected in that box. For example, if you select OK, the word yes is displayed in the XML 
reply (instead of OK).

Platforms All

Workaround None
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22 CR062855

Problem An event that follows a Start node immediately is not activated unless the flow enters a 
quiescent state before reaching that event.

Platforms All

Workaround Place a timed event before the Event node.

23 CR063114, 
CR066059

Problem Format Builder stops responding after saving an MFL document.
Format Builder uses an XSL style sheet to create DTD and XML Schema from the MFL 
documents after it is saved. Certain field combinations within an MFL document cause 
the Xalan to hang when a DTD or XML Schema document is being created.When this 
problem occurs you must terminate the Format Builder process. Do not hesitate to do so; 
you will not lose your MFL document. A DTD and or Schema will not be created, 
however. The default output setting of Format Builder automatically creates a DTD on 
save. 

Platforms All

Workaround This is a known issue caused by a Xalan problem in WebLogic Server 6.1 SP1 and SP2, 
as noted in CR063433. Use the following patch for WebLogic Server 6.1 SP2: 
CR063433_610sp2.jar. To obtain this patch, contact BEA Customer Support. The 
problem has been fixed in WebLogic Server 6.1 SP3.
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24 CR063709

Problem The RosettaNet Security Sample throws an exception when a single database is used for 
two peers and the database tables for peer1 are overwritten by peer2. (When peer1 is 
booted, it cannot add the certificate and key for the appropriate users. Because the 
database tables have been overwritten, the system boot cannot even pick the correct 
certificate names for which to search in the startup script.)

Platforms All

Workaround If possible, use different databases for different peers. For example, have peer1 use 
MSSQL and peer2, Oracle. If you must run two peers on one machine and both peers use 
the same database server, make sure that:
With MSSQL—A different database name is used for each peer, such as WLIDB for 
peer1 and WLIDB2 for peer2.
With Oracle—A different Oracle user account is used for each peer, such as kevin/kevin 
for peer1 and nina/nina for peer2.
Specify every database you use for this sample on the RunRN2Security command 
line, as follows: 
RunRN2Security database_for_peer1 database_for_peer2

setDBVars and setDBVarsExt for the two peers are set appropriately for two 
databases and users, as follows:
/bea/wlintegration2.1/config/samples/RN2Security/config/
peer1/dbInfo/database 

/bea/wlintegration2.1/config/samples/RN2Security/config/
peer2/dbInfo/database

25 CR064443

Problem The first window displayed by both the full uninstaller and the service pack upgrade 
uninstaller contains the following message:
“This will completely remove all components installed by InstallAnywhere. It will not 
remove files and folders created after the installation.”

Platforms All

Workaround This message is imprecise. It should say, instead, that the uninstall process will remove 
the upgrade and return the software to its pre-upgrade state.
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26 CR064564

Problem The organization view in the WebLogic Integration Worklist is not updated when you 
add a new organization through the following procedure:
Log in to the Studio and the Worklist with the same user account (such as joe).
In the Studio, add an organization.
Select the new organization from the Organization drop-down list.
Add yourself (joe) as a user to the new organization.
In the Worklist, look for the new organization in the drop-down list.
The problem is that the new organization is not listed. Even if you refresh the Worklist 
(by choosing View→Refresh), the organization is still not listed.

Platforms All

Workaround Log off from the Worklist and then log on again.

27 CR064716

Problem The WebLogic Integration source code checks the PRODUCTNAME column of the 
master.dbo.spt_mda table, and it relies on finding the following string: Sybase SQL 
Server. If, instead of this string, the source code finds a variable, @@version, which is 
set to Adaptive Server Enterprise, then users get the following 
com.sybase.jdbc.SybSQLException:
SET CHAINED command not allowed within multi-statement 
transaction.

Platforms Sybase 11.9.2

Workaround jConnect implements the JDBC method getDatabaseProductName by calling the 
sp_mda stored procedure that is set up by the installjconnect script. This script 
populates the master..spt_mda table with information to be returned by metadata  
access methods.
If the PRODUCTNAME column of the master.dbo.spt_mda table contains the 
@@version variable, then you must change the variable to Sybase SQL Server by 
running the following SQL statements:
update master.dbo.spt_mda set query = 'Sybase SQL Server’ 
where mdinfo = ‘PRODUCTNAME’ querytype = 6 

update master.dbo.spt_mad set query = 'select ''Sybase SQL 
Server''' where mdinfo = ‘PRODUCTNAME’ querytype = 2 
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28 CR065136

Problem The upgrade installer does not provide an option migrating the Cloudscape database.

Platforms All

Workaround None required. Cloudscape is not supported for production environments.

29 CR065392  

Problem An exception is thrown when a large (over 20 MB) binary file is received from 
WebLogic Integration - Business Connect.

Platforms All

Workaround Use the following tuning parameters:
StartWebLogic: Increase the heap size to 512MB.
Database: Make the database large (up to 300MB). 
Increase the Transaction Log space (or rollback segment) to 100MB.
Turn off the database shrinking.
WebLogic Integration [formerly WLPI] EJBs: Edit the deployment descriptors of 
wlpi-ejb.jar and wlpi-ejb-mdb.jar. Edit ejb-jar.xml from 
wlpi-ejb-mdb.jar. 
Look for all 90-second transaction timeouts and raise each one to 1090. 
Edit weblogic-ejb-jar.xml from the wlpi-ejb.jar file and raise all 90-second 
timeouts to 1090.

30 CR065397

Problem When I go to the party tab for a particular collaboration agreement and select Enable and 
Register this Collaboration Agreement, the b2b.log file seems to indicate that the 
enable-and-register operation is successful, but the B2B Console continues to wait for 
the operation to finish.

Platforms Windows (Intel)

Workaround Execute the same operation (that is, enable and register the specified collaboration 
agreement) from the monitoring tab, instead.
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31 CR065456

Problem There is no ebXML plug-in online help from the Studio help menu.

Platforms All

Workaround None

32 CR065852

Problem If you run RunSamples.cmd more than once, an exception may be generated and 
captured in the config\samples\logs\samples.log file. (The problem does not 
occur the first time you run RunSamples.cmd.)

Platforms

Workaround This exception is benign; you can ignore it.

33 CR065878  

Problem The B2B plug-in to the WebLogic Integration Studio does not set Sender Name correctly 
with XOCP SSL.

Platforms All

Workaround Change the workflow so it does not send the message to the sender name.

34 CR066176

Problem The Configure utility does not update setDBVars script. 

Platforms All

Workaround Select the CreateDB option to ensure that setDBVars is set correctly.

35 CR066179

Problem Using ebXML messaging may hang the server with high load and low ThreadCount 
settings.

Platforms All

Workaround Increase the server threadcount to approximately half the number of concurrent users 
expected.
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36 CR066059

Problem There is a Xalan problem in WebLogic Server which causes Format Builder to hang after 
saving an MFL file. The problem occurs when creating the DTD or XML Schema after 
saving the MFL document. 

Platforms

Workaround Disable automatic DTD and XML Schema creation.

37 CR076987

Problem Unable to use an XA driver with B2B.

Platforms All

Workaround None.

38 CR080411

Problem There is no XA support for transactions when using an Oracle database and driver. The 
Oracle 8.1.6 driver is no longer supported, and transaction isolation level problems occur 
when using the Oracle 8.1.7 and Oracle 9i drivers.

Platforms All

Workaround None

39 CR080449

Problem A timer sequence test may fail for a workflow with multiple timers. If there are multiple 
timers in a single workflow, they may be triggered at the same time. This is due to the 
timer resolution of plus or minus one second.

Platforms All

Workaround Do not insert more than one timed event in a workflow.
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40 CR080794,
CR081716

Problem Installation problems occur on Solaris 8 systems which use a JRE installation as the 
default Java installation.

Platforms Solaris 8

Workaround Perform a full JDK installation as opposed to a JRE-only installation. This can be done 
either with an upgrade or a reinstallation of the JDK.

41 CR080836

Problem Changes to the BPM time services to allow multiple workflow instances to be processed 
simultaneously resulted in a change in the parameters to the BPM startup class. The 
following error is reported when the server is started:
<Jun 24, 2002 1:35:25 AM PDT> <Critical> <WebLogicServer>
<Failed to invoke startup class "TimeProcessor",
java.lang.Exception: TimeProcessor startup failed! 
Check arguments.> 

Platforms All

Workaround Update the WebLogic Server configuration files (config.xml) provided in the samples 
domain as follows:
The StartupClass node for TimeProcessor should now read: 
<StartupClass
Arguments="url=t3://localhost:7001,

user=wlpisystem,pwd=wlpisystem,
connectionFactory=com.bea.wlpi.QueueConnectionFactory,
queue=com.bea.wlpi.Timer"
ClassName="com.bea.wlpi.server.timeprocessor.TimeProcessor"
FailureIsFatal="true" 
Name="TimeProcessor" Targets="myserver"/> 

The JMS topic Timer must now be a non-persistent queue:
<JMSQueue JNDIName="com.bea.wlpi.Timer" Name="Timer"/> 
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42 CR080922

Problem The Workflow Status dialog box is not automatically refreshed when you mark a task 
done that has a task permission of Mark done without executing. 

Platforms

Workaround You must close and reopen the Workflow Status dialog box to display the current status. 

43 CR081112

Problem For workflows with multiple instances of the same message type trigger, an exception 
similar to the following is thrown for the second action:
java.sql.SQLException: Transaction (Process ID 53) was
deadlocked on {lock} resources with another process and
has been chosen as the deadlock victim.

Platforms Microsoft SQL Server 2000

Workaround None

44 CR081351

Problem The workflow statistics report does not display times when WebLogic Integration is 
running over WebLogic Server 6.1 SP3 and using the Oracle 9i thin driver.

Platforms All

Workaround None

45 CR081427

Problem In some cases, the BPM plug-in action and event panels may have text distortions due to 
problems accessing resources. 

Platforms Solaris

Workaround Add the following flag to your startWeblogic script so that BPM plugin action and 
event panels display properly. 
-Dweblogic.servlet.ClasspathServlet.
disableStrictCheck="true"
BEA WebLogic Integration Release Notes 41



46 CR081732 

Problem Using WebLogic Server 6.1 SP3 with WebLogic Integration 2.1 SP2 and the Sybase 
database, an exception similar to the following is thrown when starting the server:
SET CHAINED command not allowed within multi-statement
transaction

Platforms All, with Sybase 11.9.2 database

Workaround Use the following patch for WebLogic Server 6.1 SP3: CR081732_610sp3.jar. 
To obtain this patch, contact BEA Customer Support. To apply this patch, add the path 
of the JAR file to the beginning of the classpath in $WLI_HOME/setenv.sh as 
follows:
WLICOMMONCP=../CR081732_610sp3.jar:$WLI_LIB/wlicommon.jar 

47 CR081833

Problem The wliconfig and createdb scripts behave differently in detecting changes to the 
setenv script. The Configure shortcut on the WebLogic Integration menu uses 
wliconfig.jar, which does not detect the changes in your setenv script. If you are 
going to use the Oracle9i thin driver or you need to detect changes in your setenv 
script, you must run the createdb script from the command line.

Platforms Windows

Workaround Run the createdb script from the command line to ensure that changes to the setenv 
script are detected.

48 CR081880

Problem If a dash is used in a trading partner name, WebLogic Integration - Business Connect 
converts the dash to the characters %2d% in the exported file name. This results in an 
ebXML import error with an exception message similar to the following:
Exception:SAX Exceptioncom.bea.b2b.B2BException: 
SAX Exception at
com.bea.b2b.bulkloader.BulkLoader.processDataFile
(BulkLoader.java:267)

Platforms All

Workaround Do not use dashes in the trading partner name. If dashes are required, you must manually 
remove the resulting %2d% characters from any filenames before importing the files.
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49 CR081906

Problem In some cases, Oracle streaming errors are generated when loading plug-ins. By default, 
the plug-ins are loaded automatically. This problem may occur when you load plug-ins 
manually. 

Platforms

Workaround Restart the server

50 CR081927

Problem When using the Format Builder, if the encoding specified for the Default Message 
Format differs from the encoding specified for the Default Field Code Page, binary 
generation fails. 

Platforms All

Workaround Specify the same encoding for the Default Message Format and the Default Field Code 
Page.

51 CR081986

Problem When enabling and registering a collaboration agreement (CA) between two trading 
partners using ebXML, the B2B Console hangs. However, log messages indicate that the 
CA was registered with the server. 

Platforms Windows

Workaround Open another browser to display the modified B2B Console output.

52 CR082488

Problem The RunSamples script does not properly load the application integration and BPM 
templates on a Japanese platform. 

Platforms All

Workaround Use the US mode of WebLogic Server by changing the code page to US ASCII. (On 
Japanese Windows systems, run us.bat to change the code page.) Then run the 
RunSamples script, which automatically loads the application integration and BPM 
templates.
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53 CR082583

Problem All out-of-the box domains shipped in WebLogic Integration 2.1 SP2 do not have the 
B2B error queue configured. This causes the following warning to appear at regular 
intervals, which can result in large log files:
####<Jul 17, 2002 5:02:44 PM PDT> <Warning> <EJB> <mymachine>
<myserver> <main> <system> <> <010061> 
<The Message-Driven EJB: EBXMLErrorQListener is unable to
connect to the JMS destination: com.bea.b2b.ErrorQueue.

Platforms All

Workaround Add the B2B error queue definition to the config.xml file. Locate the 
B2bOutboundQueue in your config.xml file: 
<JMSQueue JNDIName="com.bea.b2b.OutboundQueue"
Name="B2bOutboundQueue"/> 

Below this queue definition, add the B2B error queue definition as follows: 
<JMSQueue JNDIName="com.bea.b2b.OutboundQueue"
Name="B2bOutboundQueue"/> <JMSQueue
JNDIName="com.bea.b2b.ErrorQueue" Name="B2bErrorQueue"/> 

54 CR082585  

Problem The WebLogic Integration 2.1 SP2 upgrade installer overwrites the peers database user 
schema and URL for the RosettaNet 2 Security sample. To use the RosettaNet 2 Security 
sample, you must change at least one peer to use a different database user schema. After 
performing an upgrade installation, the values of the URL and user-specified database 
values in the peer1 and peer2 directories reflect the default user schema and URL 
used in the samples domain. The following files are overwritten in the peer1 and 
peer2 directories:
config.xml
setdbvars
setdbvarsext

Platforms All

Workaround After performing an upgrade installation but before running the migratedb script, edit 
the database user schema and URL in the peer1 and peer2 directories in the files listed 
above. If you run the migratedb script before editing the files, a database user schema 
that was not intended for use will be migrated and the sample will not run properly.
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55 CR082665  

Problem Task and workflow comments are being truncated.
Workflow and task comments are limited to a maximum of 254 characters. Comments 
exceeding this limit are truncated and no exception is thrown.

Platforms All

Workaround Do not include more than 254 characters in your task and workflow comments.

56 CR082763  

Problem The client certificate is not recognized when using two-way SSL on Microsoft IIS with 
a WebLogic Server proxy plug-in.. When a business message is forwarded from the 
plug-in, an exception similar to the following is thrown:
<Plug-Ins> com.bea.b2b.protocol.PlugInException: 
Invalid Trading Partner Certificate 

Platforms All

Workaround The following properties were added to WebLogic Server 6.1 SP2. As a workaround, 
add these properties to the web.xml file for the Default Web application using the 
configuration detailed in the problem description.
tested ServletRequestImpl context-param

<context-param>
<param-name>weblogic.httpd.clientCertProxy</param-name>
<param-value>true</param-value>

</context-param>

tested Cluster-wide switch
<Cluster ClusterAddress="127.0.0.1" Name="MyCluster"
ClientCertProxyEnabled="true"/> 

test HttpClusterServlet context-param 
<context-param>
<param-name>weblogic.httpd.clientCertProxy</param-name>
<param-value>true</param-value>

</context-param>
BEA WebLogic Integration Release Notes 45



XA For Transactions Not Supported

There is no support for XA for transactions in this release. Related Change Requests 
include CR076987 and CR080411.

Creating a Database on UNIX Systems Using Microsoft 
SQL Server

Because Microsoft SQL Server is not supported on UNIX systems, you cannot use the 
createdb script (WLI_HOME/bin/createdb.*) to configure your Microsoft SQL 
Server 7.0 or Microsoft SQL Server 2000 database on UNIX. 

Database Limits on Strings

WebLogic Integration limits the number of characters you can include in a string for a 
B2B integration entity. If the only consideration in determining such limits were the 
need to be consistent with the repository, the limit would be 256 characters. Many 
other factors, however, must be considered: required indexing for deadlock 
prevention, data integrity and constraints, indices on multiple columns (for example, 
MessageId and DeliveryChannel), and inherent database-specific index size 
limitations. Therefore, we recommend the values listed in the following table.

Limits on Length of Database Character Strings

Entity Oracle MSSQL Cloudscape

TradingPartner 256 256 256

DeliveryChannel 252 128 256
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Displaying Spaces in the Studio 

The WebLogic Integration Studio running on a Solaris system renders spaces as empty 
box characters. 

Undeploying Application Integration EJB While Using 
BPM 

If the wlai-ejb-server EJB is undeployed or goes down while you are using 
business process management (BPM) functionality with the application integration 
plug-in, an exception similar to the following may be thrown: 

Unknown error: NameNotFoundException: Unable to resolve
com.bea.wlpi.Admin. Resolved: 'com.bea.wlpi' Unresolved:'Admin' 

If you then deploy the wlai-ejb-server EJB from the WebLogic Server Console, 
the application integration plug-in for BPM cannot detect that it has been redeployed 
and throws an exception similar to the following: 

The server was unable to complete your request. 
NoSuchObjectException: RemoteInvokable - id: '319' 
java.rmi.NoSuchObjectException: RemoteInvokable - id: '319' 

As a workaround, restart WebLogic Server after redeploying the wlai-ejb-server 
EJB. 

X Window Emulator and Telnet Connections to UNIX 

The GUI-based installer for WebLogic Integration (which is written in Java) is not 
certified to run on a UNIX system reached through an X Window emulator or Telnet 
connection. Instead, we recommend a direct X Window connection. You can also use 
the console-mode installation procedure on UNIX systems without a graphics 
(windowing) workstation.
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Deploying the Plug-In Sample on UNIX Platforms 

If you see the following error message when you start WebLogic Integration on UNIX 
platforms, you are probably running the software from a terminal with no graphics 
capability:

Error initializing plugin:
com.bea.wlpi.tour.po.plugin.SamplePluginBeanHomeImpl@175d46
java.rmi.RemoteException: Exception in ejbCreate(); nested
exception is: java.lang.InternalError: Can’t connect to x11 window
server using “ as the value of the DISPLAY variable.
java.lang.InternalError: Can’t connect to X11 window server using
“ as the value of the DISPLAY variable.

If you are using a terminal with no graphics capability, nothing can be done about this 
error. The plug-in sample cannot be deployed, and you cannot run some workflows 
that require this plug-in.

If you are using an X terminal, set the DISPLAY variable, and restart the server. The 
message should not appear again.

Nonpersistent Mode Recommended for B2B Integration 

We recommend that you use the B2B integration functionality in nonpersistent mode. 
For details about invoking nonpersistent mode, see “Configuring Persistence and 
Recovery” in Administering B2B Integration.

When using B2B in persistent mode, be sure to change the defaultdeliverymode 
setting for JMSConnectionFactory to non-persistence. (The default setting is 
persistence.)
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Collaboration Agreements Between Delivery Channels 
for the Same Trading Partner Not Supported

If you configure two XOCP delivery channels (one hub and one spoke) for a single 
trading partner, with a collaboration agreement between them, and you subsequently 
use the WebLogic Integration Studio to define the Start Public Workflow action for the 
workflows in the associated conversation, you get a duplicate trading partner 
error.

To work around this problem, do not set up one trading partner with two delivery 
channels. Instead, set up two trading partners, each with its own delivery channel. 
Configure a hub delivery channel for one trading partner, and a spoke delivery channel 
for the other.

Problems Viewing PIP Instance Variables 

When you attempt to list the variables of certain RosettaNet PIP instances, using the 
WebLogic Integration Studio, the following error may be reported:

unknown error: ClassNotFoundException: 
com.bea.b2b.protocol.rosettanet.businessop.TemplateSysVariable

This TemplateSysVariable class is found in wlc.jar. To avoid this problem, put 
wlc.jar in the Studio classpath. This problem was previously recorded as CR054700.
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Setting the Time Zone (TZ) Environment Variable for the 
JavaDate Type

On UNIX systems, the JavaDate type does not return a date with the appropriate time 
zone indicator unless the time zone variable, TZ, is set. Ensure that the TZ environment 
variable is set to the appropriate time zone.

The following example shows how to set the TZ environment variable:

TZ=US/Central
export TZ

The system administrator should set this variable before installing WebLogic 
Integration 2.1 Service Pack 1. If you experience problems with the time zone indicator 
on your system, contact your system administrator.

When the time zone environment variable is not set, the XML returned for a JavaDate 
type field is specified in Greenwich Meridian Time (GMT) as follows:

<Date>Wed Nov 15 10:55:37 GMT-06:00 2001</Date>

When the TZ variable is set to your time zone, the XML that is returned reflects your 
local time zone, as shown in the following example:

<Date>Wed Nov 15 4:55:37 CST 2001</Date>

WebLogic Integration Studio Online Help Refresh 
Limitations 

Given certain settings for file types on your system when using Microsoft Internet 
Explorer as your default browser, you may encounter a limitation when refreshing 
HTML frames. This refresh limitation prevents online help pages from being displayed 
properly. For example, when you click the Help icon at the product user interface entry 
point, the initial online help splash page should be displayed. If, while navigating the 
help system, you click the Help icon again and the splash page is not reloaded as 
expected, the cause of the problem is probably this refresh limitation.

To work around this limitation, change your system file type settings by completing 
the following procedure:
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1. Choose Start→Settings→Folder Options to display the Folder Options dialog box. 

Alternatively, you can double-click the My Computer icon to display the My 
Computer window. 

2. From the main menu, choose View→Folder Options to display the Folder 
Options dialog box.

3. Select the File Types tab. 

4. Using the scroll bar to the right of the Registered file types drop-down list, 
review the list of file types and select HTML Document. In the File type details 
field, the program specified in the Opens with field is IEXPLORE.

5. Click Edit to display the Edit File Type dialog box.

6. In the Actions list field, select Open in Same Window.

7. Click Set Default.

8. Click Close to close the Edit File Type dialog box.

9. Click Close to close the Folder Options dialog box.

Viewing the Studio Online Help Using Netscape 
Navigator on UNIX Platforms 

To view the Online Help for individual Studio dialog boxes using Netscape Navigator 
on UNIX platforms, open the browser first. Once the browser is open, you can click 
the Help button in any dialog box or press the F1 key.

B2B Console Hangs When You Enable and Register a 
Collaboration Agreement 

The B2B Console allows you to configure collaboration agreements and make them 
available immediately by enabling and registering them. (For details, see “Configuring 
Collaboration Agreements” in the B2B Console Online Help.) 
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In the following situation, however, the B2B Console may hang:

1. You choose Configuration→Parties. On the Parties tab the Enable and register this 
Collaboration Agreement check box is selected.

2. You click the Add/Apply button.

To work around this limitation:

1. Deselect the check box labeled Enable and register this Collaboration Agreement, 
and click Add/Apply. 

2. Select the Monitoring tab and click the Enable this Collaboration Agreement link.

3. Select the Monitoring tab again (if it is not displayed), and click the Register this 
Collaboration Agreement link.
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Documentation Additions, Changes, and Corrections
Documentation Additions, Changes, and 
Corrections

This section provides additions, changes, and corrections to the WebLogic Integration 
documentation available on the BEA documentation Web site at the following URL:

http://edocs.bea.com

Composing XML from Sub-Documents

The following information will be added to Using the WebLogic Integration Studio in 
a future release. The features described were added in response to CR070352.

This release provides you with additional flexibility in working with XML data in the 
Studio. The Set Workflow Variable, Post XML Event, and Send XML to Client 
dialogue boxes now include a check box labeled as follows: Escape XML reserve 
characters in generated node values. Figure 1 shows the new Set Workflow Variable 
dialog box.
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Figure 1   Set Workflow Variable Dialog Box
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By default, this check box is selected. This means that reserved characters, such as the 
ampersand (&) or right angle bracket (<), are escaped in order to preserve the validity 
of the XML document. For example, & and < would be replaced with &amp; and &lt; 
respectively. In the above example, the variable companyXml contains 
<name>PG&amp;E</name>.

However, consider the following example using the XML variables, as shown in 
Figure 2:

xmlsub1: <sub-elem-1>value 1</sub-elem-1>
xmlsub2: 
<sub-elem-2>
<ss-elem>value 1</ss-elem>
<ss-elem>value 2</ss-elem>
<ss-elem>value 3</ss-elem>
<ss-elem>value 4</ss-elem>
</sub-elem-2>
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Figure 2   Post XML Event Dialog Box with Escape XML Check Box Enabled

The XML that is sent from this Post XML Event action contains:

<?xml version="1.0" encoding="UTF-8"?>
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<root>

<element-1>&lt;sub-elem-1&gt;value
1&lt;/sub-elem-1&gt;</element-1>

<element-2>&lt;sub-elem-2&gt;
&lt;ss-elem&gt;value 1&lt;/ss-elem&gt;
&lt;ss-elem&gt;value 2&lt;/ss-elem&gt;
&lt;ss-elem&gt;value 3&lt;/ss-elem&gt;
&lt;ss-elem&gt;value 4&lt;/ss-elem&gt;
&lt;/sub-elem-2&gt;</element-2>

</root>

Disabling the Escape XML reserved characters check box leaves the data as generated, 
as shown in Figure 3. This is useful for creating XML documents from subdocuments.
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Figure 3   Post XML Event Dialog Box with Escape XML Check Box Disabled

This results in a properly formed XML document being sent:
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<?xml version="1.0" encoding="UTF-8"?>
<root>
<element-1>

<sub-elem-1>value 1</sub-elem-1>
</element-1>
<element-2>

<sub-elem-2>
<ss-elem>value 1</ss-elem>
<ss-elem>value 2</ss-elem>
<ss-elem>value 3</ss-elem>
<ss-elem>value 4</ss-elem>

</sub-elem-2>
</element-2>
</root>

This release also supports the ability to pass an XML subdocument as an XSL 
transform parameter, as shown in Figure 4:
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Figure 4   XSL Transfor Dialog Box Used to Pass an XML Subdocument

The variable contents are:

xmlsub1: <sub-elem-1>value 1</sub-elem-1>
xmlsub2: 
<sub-elem-2>
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<ss-elem>value 1</ss-elem>
<ss-elem>value 2</ss-elem>
<ss-elem>value 3</ss-elem>
<ss-elem>value 4</ss-elem>

</sub-elem-2>

The XSL Transformation contains:

<xsl:param name="testParam1"/>
<xsl:param name="testParam2"/>
<xsl:param name="testParam3"/>

<xsl:template match="/">
<out>
<date>

<xsl:value-of select="$testParam1"/>
</date>

<xmlsub1>
<xsl:copy-of select="$testParam2"/>

</xmlsub1>
<xmlsub2>

<xsl:copy-of select="$testParam3"/>
</xmlsub2>

</out>

The result of the transformation returned in xmlout is as follows:

<?xml version="1.0" encoding="UTF-8"?>
<out>

<date>Mon Mar 18 11:40:43 PST 2002</date>
<xmlsub1>
<sub-elem-1>value 1</sub-elem-1></xmlsub1>

<xmlsub2>
<sub-elem-2>

<ss-elem>value 1</ss-elem>
<ss-elem>value 2</ss-elem>
<ss-elem>value 3</ss-elem>
<ss-elem>value 4</ss-elem>

</sub-elem-2></xmlsub2>
</out>
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Time Services Changes in BPM

This section includes information on changes to time services in BPM. This 
information will be added to the BPM documentation in a future release.

The BPM time services now allow multiple workflow instances to be processed 
simultaneously when started by a time trigger. Previously, all time actions were 
processed sequentially by a single instance of the Message-Driven Bean (MDB) 
TimeListenerBean. Now, instead of being a singleton, TimeListenerBean is initially 
deployed with 5 instances. It uses the wlpiOrderKey = <instance id> message 
header for message selection to ensure that timer actions are processed sequentially for 
any given instance and different instances are processed by a different bean.

Information for Deployers

Users deploying applications should note that a prime number of TimeListenerBeans 
must be deployed to ensure that any one instance’s time actions are processed by the 
same MDB. This preserves the sequence of time actions within an instance. 

Information for Administrators

Administrators should update the WebLogic Server configuration file, config.xml, 
with the required arguments for the 
com.bea.wlpi.server.timeprocessor.TimeProcessor startup class. A sample 
follows:

<StartupClass
Arguments="url=t3://localhost:7001,user=wlpisystem,
pwd=wlpisystem,
connectionFactory=com.bea.wlpi.QueueConnectionFactory,
queue=com.bea.wlpi.Timer"
ClassName="com.bea.wlpi.server.timeprocessor.TimeProcessor"
FailureIsFatal="true" Name="TimeProcessor"
Targets="myserver"/>

where:
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url = URL of the server that the TimeProcessor is deployed on
user = the wlpisystem user
pwd = wlpisystem user's password
connectionFactory = JNDI name of the WLPI connection factory
queue = JNDI name of the Timer queue

Also, note the addition of FailureIsfatal="true".

Information for Application Designers

Users designing applications should note that since the instance ID is used as the 
message selector for the MDBs, it is possible that time actions could all get sent to the 
same TimeListenerBean. This occurs in situations where the instance containing the 
time action is always a factor of the number of deployed TimeListenerBeans. 

For example, if 3 TimeListenerBeans are deployed and the application has the 
following template definitions: 

Parent→Child→Grandchild

where the Grandchild template definition performs a time action such as Task Due 
Date, and then starts another instance of the Parent. This results in the instance of 
Grandchild always going to the same MDB because the result of the following 
calculation:

<instance#>%3 (the remainder of <instance>/3) 

will always be the same, assuming these are the only workflows running). 

Time-Based Processing and WebLogic Time Services

BPM time-based processing is now coupled more closely with WebLogic Time 
Services. This affects the trigger time of time-based actions in a BPM workflow. The 
accuracy of timers is dependent on that of the underlying WebLogic Server timers, 
with a resolution of milliseconds but an accuracy of plus or minus roughly one second. 
This means that time based actions may fire up to one second prematurely. Time-based 
actions should, therefore, not be used for timing-critical designs needing extreme 
accuracy.
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Time processing occurs in a separate execution thread from that of the workflow. 
When a timer triggers, the TimeListener MDB attempts to resume processing of the 
workflow in which the timer was scheduled. In certain situations, it is possible for the 
timer to trigger prior to the workflow instance having been committed to the database, 
resulting in a message similar to the following:

Workflow warning: com.bea.wlpi.common.WorkflowException: 
The system could not find the specified workflow instance:IID

where IID is the instance ID of the workflow.

This only occurs in design patterns where a time-based action is performed in the first 
transaction of the workflow, and when the timer is scheduled for a period of time 
shorter than it takes the workflow to complete.

For example, consider a workflow template definition comprised of the following 
nodes:

Start→Task1→Task2→Event→Done

where:

Task1 performs a timed event action that sets the timer for 1 second
Task2 performs some simple processing
Event waits for a message and then processes it

Under normal circumstances, workflow processing starts and the timer is set in Task1 
for (current_time + 1 second). The workflow processor moves to Task2 and 
executes its actions. The Event node is reached and the transaction is committed. The 
workflow is now stored in the database. The timed-based action fires and resumes 
processing the instance, performing those tasks in the overdue action list (canceling the 
event, for example) if the workflow has not completed.

In this example there is a very high probability that, if the workflow is called 
repeatedly, at one point the timer will fire early enough and the latency before the 
transaction commits will be long enough that the timer processing begins before the 
workflow instance has been committed to the database. In testing, we have found that 
the situation occurred after 249, 750, and 1122 instance have processed normally. 
Obviously, the probability of this occurrence increases as the time for the trigger 
decreases and the amount of processing prior to the workflow instance being 
committed to the database increases (more actions are performed prior to the first 
quiescent point).
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Correct Sequence of Steps for Monitoring Running 
Workflows

In Executing and Monitoring the Example Workflows in Learning to Use BPM with 
WebLogic Integration, under the section “Monitoring the Running Workflows in the 
Studio”, steps 15 and 16 are reversed, causing problems in properly updating variables. 
This problem was reported as CR080585. The correct sequence of steps is as follows:

14. Return to the Worklist window. 

15. Select the Accounting tab, and double-click the Generate Invoice task. In the 
Error Warning message box, enter a valid state abbreviation, such as CA. 

16. Select the Shipping role tab, and double-click the Ship Order task to execute 
it. 

17. Return to the Studio. 

Workflow Status Is Not Automatically Refreshed

The Workflow Status dialog box is not automatically refreshed when you mark a task 
done that has a task permission of Mark done without executing. You must close and 
reopen the Workflow Status dialog box to display the current status. This behavior was 
reported in CR080922 and will be reflected in the Worklist documentation in a future 
release per CR080930.

Data Integration Padding and Truncation Features

This section includes information on enhancements to the data integration 
functionality provided by WebLogic Integration 2.1 SP1. This information will be 
added to Translating Data with WebLogic Integration in a future release. Specifically, 
it provides an enhanced version of Message Format Language, MFL Version 2.02, 
with three new features supported by this new version of MFL:

Padding 

Truncating 
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Padding of mandatory fields

Note: All prior versions to 2.02 versions of MFL are completely supported.

Padding 

Fixed-length fields containing data with a length shorter than the length specified in 
the MFL definition are padded. In previous versions, padding was limited to padding 
fields only at the end of the field. In MFL v2.02, the padding feature offers two options 
for padding fixed-length fields: 

Padding by Trailing option—allows padding at the end of fields

Padding by Leading option—allows padding at the beginning of fields

You can specify either but not both of these options. Padding of fields is done when 
fields are translated from binary to XML and from XML to binary. MFL v2.02 
provides a new attribute, padtype, which can be specified with a value of either 
leading or trailing.

Padding at the beginning of a field is indicated by the following:

padType=”leading” 

Padding at the end of a field is indicated by the following:

padType=”trailing” 

Truncating

In MFL v 2.02 includes a new truncation option. Using this feature, you can specify 
the number of characters to be truncated at the start or the end of the field data. Two 
truncation options are provided:

Truncate First n characters

Truncate After n characters

Both options require you to specify the number of characters (denoted by n).

If the Truncate First n characters option is selected, the first n number of characters are 
removed or truncated from the field. The value n should be an integer less than or equal 
to the length of the field.
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If the Truncate After n characters option is selected, all characters after the nth 
character position from the start of the field are truncated. This feature is only offered 
for XML-to-binary translations. You can select either option or both options.

MFL v2.02 provides a two new attributes to support this feature: truncateFirst and 
truncateAfter. Both attributes take integer values indicating the number of 
characters to truncate.

For example, truncateFirst=”2” truncates the first 2 characters of the field. 
Specifying truncateAfter=”3” truncates everything after 3 characters.

Padding of Mandatory Fields

This padding of mandatory fields option is provided so that mandatory groups or 
mandatory fields that do not have data at translation time are filled or padded if a 
default value is provided for the field. If no default value is specified and the field does 
not have data during translation, than an error is generated. This feature is useful in the 
case of groups occurring multiple times, where data for all fields in the group is the 
same. By providing default values for all the fields in the group, those group 
occurrences without data are padded with default values.

This feature works is only offered for XML-to-binary translations. There is no MFL 
change for this feature.

Bulk Loader Errors and Improper B2B Shutdown

The following information will be added to Administering B2B Integration in a future 
release. This information was compiled in response to CR049068.

If you shut down the B2B engine abnormally and subsequently try to use the Bulk 
Loader utility, you get an error message, indicating that the B2B engine is still running 
or was shut down abnormally, similar to the following:

D:\bea\wlintegration2.0\collaborate\bin\systemData>
bulkloader BulkloadMssqlConfig.xml <May 30, 2001 2:22:10 PM PDT>
<Error> <WLC> <<BulkLoader> ERROR: Can not run bulkloader when WLC
is running.> ERROR: Can not run bulkloader when WLC is running.

Shut down the B2B engine from the WebLogic Integration B2B Console. Do not use 
Ctrl-C to shut down the B2B engine. For recommended ways to shut down the B2B 
engine, see “Monitoring B2B Integration” in Administering B2B Integration.
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Installation and Migration

This section discusses WebLogic Integration 2.1 SP2 installation and migration and 
includes the following topics:

Full Installation

Upgrade Installation

Migrating from WebLogic Integration 2.1

Migrating from WebLogic Integration 2.1 SP1

Full Installation

WebLogic Integration 2.1 SP2 uses the standard BEA installer. No changes to the full 
installation procedure were made for WebLogic Integration 2.1 SP2.

Upgrade Installation

An upgrade installer is provided that allows you to update WebLogic Integration 2.1 
SP1 to WebLogic Integration 2.1 SP2.

WebLogic Integration 2.1 SP2 uses the standard BEA upgrade installer which overlays 
an existing installation after backing up user-modifiable files. The upgrade installer 
functionality has not changed for this release. For instructions on performing a service 
pack upgrade, see “Installing and Uninstalling Service Pack Upgrades” at the 
following URL:

http://edocs.bea.com/wlintegration/v2_1sp/install/instupg.htm

To migrate from WebLogic Integration 2.1 to WebLogic Integration 2.1 SP2 an 
addition to the database is required. The ebXML feature, which was added in 
WebLogic Integration 2.1 SP1, requires the addition of a new table along with some 
new rows being added to existing system tables. There is a script that performs this 
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update which is accessible from the upgrade wizard and from the command line 
scripts. For a reference to relevant migration documentation, see “Migrating from 
WebLogic Integration 2.1” on page 69.

No addition to the database is required to migrate from WebLogic Integration 2.1 SP1 
to WebLogic Integration 2.1 SP2. 

If you are using a version of WebLogic Integration prior to release 2.1, existing 
methods of migrating to WebLogic Integration 2.1 are retained. Depending on the 
version of WebLogic Integration that you have installed, this may involve more than 
one step. You will need access to the migration utilities and scripts that are currently 
delivered as part of the WebLogic Integration 2.1 installation package. 

Migrating from WebLogic Integration 2.1

The migration tasks required when upgrading from WebLogic Integration 2.1 to 
WebLogic Integration 2.1 SP2 and the same as those required when upgrading from 
release 2.1 to release 2.1 SP1. For a description of migration tasks, see Migrating 
WebLogic Integration 2.1 to WebLogic Integration 2.1 Service Pack 1 at the following 
location:

http://edocs.bea.com/wlintegration/v2_1sp/migrate/berlsp1.htm

Migrating from WebLogic Integration 2.1 SP1

There are no migration tasks required when upgrading from WebLogic Integration 2.1 
SP1 to WebLogic Integration 2.1 SP2.
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BEA dev2dev Online

Visit the BEA dev2dev Online to obtain helpful resources that you might find useful 
when creating your WebLogic Integration applications. Additional development tools, 
ideas, and programming tips are continuously added to this site, which we encourage 
you to visit often.

You can reach BEA dev2dev Online at the following URL:

http://dev2dev.bea.com/index.jsp

Contacting BEA Customer Support

If you have questions about this release of the WebLogic Integration software, if you 
encounter problems while installing and running the software, or if you need to obtain 
patches, contact the BEA Customer Support Center at the following URL:

http://www.bea.com/support

You can also contact your BEA Customer Support Center by using the contact 
information provided on the Customer Support Card, which is included in the product 
package.

When contacting your BEA Customer Support Center, be prepared to provide the 
following information:

Your name, e-mail address, phone number, and fax number

Name and address of your company

Your machine type and authorization codes

Name and release of the product you are using

Description of the problem and the content of pertinent error messages
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